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Introduction

INTRODUCTION

SafePace Cloud is a web based, radar sign management solution developed by Traffic Logix. It uses the power of 
the Web Director engine to allow you to monitor and manage all aspects of your SafePace signs without leaving 
your desk. SafePace Cloud powered by Web Director allows you to do the following: 

» Monitor and manage your signs and their locations 

» Configure the display settings of your signs

» Specify displayed messages

» Handle alerts from the signs

» Generate and print statistical reports based on data gathered by the signs

Browser Requirements

Web Director is designed to work with the following browsers:

» Mozilla Firefox 

» Google Chrome
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About this Quick Start Guide

About this Quick Start Guide
This Quick Start Guide is meant for  anyone who needs to set up SafePace Cloud powered by Web Director to 
work with a Traffic Logix radar sign (GSM models) for the first time. It is intended to allow you to get up and run-
ning quickly with your radar sign and Web Director. It provides an introduction to Web Director and describes the 
basic use and configuration of the system including the following:

» Starting the sign 

» Obtaining the serial number for the sign controller

» Setting display parameters for the signs

» Specifying the locations for your signs

» Assigning signs to locations

» Monitoring the real-time data from the signs

In addition, this guide presumes that you have already unpacked and set up your signs as per the included install-
ation instructions. Should you need more information on any of the features of Web Director, you can refer to the 
Web Director User Guide. 

TIP: We recommend that you set up your sign(s) in-house and that you follow the procedures in this 
guide to verify that the sign(s) operate well together with Web Director  before you install the sign(s) on 
location.
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Documentation Conventions

Documentation Conventions
This document uses the following formatting conventions:

Format Description

Bold Gray  Used in procedures to indicate menu commands, interface controls 
and dialog box options.

Italics Used to place emphasis on certain words.

Monospace text Is used for code samples and any information that the user enters.

Italicized mono-
space text

Used to indicate text that you should replace with your own. For 
example: In the Save As text box, enter c:\filename.ext where file-
name.ext is the name of the file you want to save.

> Used to indicate a sequence of commands (and sub commands) to be 
carried out in the displayed order. For example File > Exit means to 
open the File menu then choose the Exit command. This applies to 
menus from the main menu bar, context menus that appear when you 
right-click on the interface, and tiles in a tiled interface.

 

NOTE: Notes are used as reminders or to provide information of interest that supplements or emphas-
izes important points of the main text..

TIP: Tips are used to suggest alternative methods,  workarounds and/or shortcuts that are not essential 
but that you may find useful in a given situation.

CAUTION: Cautions are used to advise users of specific actions that could result in a loss of data.

WARNING: Warnings are used to advise users of specific actions that could result in personal physical 
injury or damage to equipment.
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Before You Start

BEFORE YOU START

Before you get started with SafePace Cloud, there are a couple of things that you need to do. First you need to 
turn the sign on and verify that it starts up correctly. Once that step has been completed you can then take note of 
the serial number of the controller. This serial number is used to identify the sign to Web Director and allows you 
to specify which sign is installed in which location.

Starting the Sign

There is no ON/OFF switch supplied with the radar speed signs. The sign immediately powers on once the power 
source is connected. Once the sign is powered on it should go through a start up sequence. After a successful com-
pletion of the start up sequence, the sign displays one of the following messages.

» IP on - Displayed by static YOUR SPEED and static SPEED LIMIT signs

» GPRS Connect - Displayed by Variable Message Signs

Getting the Serial Number of the Controller 

The serial number of the controller card is used to identify the sign to  Web Director. This number is separate from 
the serial number of the sign itself. 

TIP: Keep a record of which serial number will be assigned to each proposed location.

To get the serial number of the controller:

1. Open the sign.

2. On the inside of the front cover of the sign, locate  the controller card (normally green in color).

You will find the serial number printed on a small white sticker typically placed in the lower-right or upper-left 
corner of the controller card depending on the model of the sign. 

Figure 1: Location of the serial number on the controller card

NOTE: If there is no sticker on the controller card, please contact our Technical Support department for 
help in determining the serial number of the controller. See Contacting Technical Support on page 26.
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GETTING STARTED WITH WEB DIRECTOR
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Signing In and Out of the Web Director User Interface

Signing In and Out of the Web Director User Interface

To sign in to Web Director:

1. Using your browser, navigate to the SafePace Cloud URL. 

The Web Director Sign In page is displayed.

2. Specify your Login and Password credentials, then click the  icon.

This signs you in to Web Director and displays the Web Director home page. 

If this is the first time you are signing in, you will need to change your password. In this case, the Password 
Expiry page is displayed.

3. Fill in the following fields:

• Old Password — Type your current password.

• New Password — Type the new password.

• Confirm Password — Retype your new password.

NOTE: Though these rules can be changed, by default passwords should be at least three(3) characters 
long, with at least one(1) upper-case letter and one(1) digit.

4. When you are finished, click OK.

The  Web Director home page is displayed. 
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Signing In and Out of the Web Director User Interface

To sign out of Web Director:

» In the Menu bar, click the user menu then choose Logout.

This signs you out from Web Director and displays the sign in screen.
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Navigating the Web Director User Interface

Navigating the Web Director User Interface
As shown in the following image the home page of Web Director  is a tiled interface with a menu bar across the 
top. The tiles allow you to navigate to the different areas of the Web Director application.

Figure 2: The Web Director User Interface

The actual tiles displayed varies depending on your permissions, however, the full list of available tiles is as fol-
lows:

» Alerts – Allows you to process any alerts generated by Web Director.

» Dashboard – Displays a tabular view of your locations and, the status and real-time readings from any asso-
ciated radar signs.

» Manage Locations – Allows you to set and manage the locations where you have signs installed.

» Map – Displays a map of your locations  and allows you to see the status of, and selected real-time readings 
from, the associated radar signs.

» Reports – Allows you to generate charts and reports based on the data collected by the radar signs.

» System Parameters – Allows you to configure the system settings for Web Director.

» Tools – Allows you to configure and manage your installed devices.

» User Management – Allows you to create and manage  users' accounts.

To access the related section:

Click the relevant tile.

See Also:
» Using the Menu Bar on the next page
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Using the Menu Bar

Using the Menu Bar

The menu bar is displayed across the top of each page of the Web Director user interface.  It contains options to 
allow you to do the following:

Icon Name Description

Back Returns to the previous page in Web Director.

Refresh Refreshes the current page.

Map View Displays a map of your locations  and allows you to see 
the status of, and selected real-time readings from, the 
associated radar signs.

Dashboards Displays a tabular view of your locations and, the status 
and real-time readings from any associated  radar signs.

Tools Allows you to configure and manage your installed 
devices.

Reports Allows you to generate charts and reports based on the 
data collected.

Manage 
Locations

Allows you to set and manage locations.

Alerts Allows you to process any alerts generated by Web Dir-
ector.

The following options are located on the far right side of the menu bar.

User Menu Opens a menu that contains the following options:

• Edit Profile – Allows you to edit your user profile.

• Logout – Allows you to sign out from Web Director.

Help Opens the Web Director Online User Guide.
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Configuring Radar Sign System Parameters

Configuring Radar Sign System Parameters
Configuring system parameters allows you to customize Web Director to meet your organization’s requirements. 

To configure radar sign system parameters:

1. From the Web Director home page, click the   System Parameters > Radar Signs Parameters tiles.

The Radar Sign System Settings page is displayed.

2. Make any necessary changes to the available parameters. For descriptions of the available parameters, see 
Radar Sign System Parameters below.

3. When you are finished, click Save.

Your changes are saved.

Radar Sign System Parameters

The following group of parameters allow you to specify the intervals used for displaying traffic statistics and 
determining if signs are still connected.

Parameter Definition

Display traffic statistics 
interval

Specifies the interval for the retrieval of traffic statistics. The available 
intervals are as follows:

• 5 minutes

• 10 minutes

• 15 minutes

• 30 minutes

• 1 hour

• 2 hours

• 24 hours

Readings invalidation 
interval

Specifies the period of time after which, if a radar sign hasn’t con-
nected to  the server, it will be considered disconnected. Any dis-
connected signs are displayed in red in Map View and the Dashboard. 
The available intervals are as follows:

• 10 minutes

• 15 minutes

• 20 minutes

• 30 minutes
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Radar Sign System Parameters

Parameter Definition

• 45 minutes

• 1 hour

• 3 hours
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Setting Up Your Locations

Setting Up Your Locations
In Web Director, a location represents the actual physical address where you place a sign. Web Director allows you 
to create multiple locations, to which you can later assign signs. Your typical workflow is as follows:

1. Create the Locations

2. Assign Signs to the  Locations

Creating a Location 

In Web Director use the Manage Locations page to create locations for your signs. 

To create a location:

1. In the floating Tools toolbar, click the Add Location button.

A flashing (red/yellow) map marker is displayed on the map.

2. Drag the map marker to the area on the map where you want to create the location.

TIP: Use the Pan and Zoom controls to  get a more precise location placement and address.

The location's address is displayed in the left sidebar, under Selected address.

3. Once the location is set, click OK. 

The Location Parameters are displayed and the map marker turns green.
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Assigning Signs to Locations

4. Specify the necessary parameters.

5. When you are finished, click OK.

The location is displayed in the listing.

Assigning Signs to Locations

In Web Director,  use the Manage Locations page to assign signs to locations. When you assign a sign to a location 
any data collected by that sign is then associated with that location in Web Director. Should you then assign the 
sign to a new location the data collected at the old location remains associated with that location. Any data col-
lected from the new location is associated with the new location. However, it remains up to you to make sure that 
the sign is physically located at the specified location.

To assign a sign to a location:

1. From the Manage Locations page, select the location where you want to assign the sign.

The location listing expands.

2. Click the Radar Signs icon. 

The Sign Location dialog box is displayed.
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Assigning Signs to Locations

3. Click the Signs list box then choose the sign you want to assign from the list.

The signs are identified by the serial number of the controller card and you can select any of the signs listed. 

NOTE: If you select a sign that is already assigned to another location, it will be removed from that loc-
ation and reassigned to the current one.

4. When you are finished, click Save. 

5. When prompted, click OK to confirm your changes.

A blue Radar Sign icon is displayed in the listing for the location.

To remove a sign from a location:

1. Select the location from which you want to remove the sign.

The location listing expands.

2. Click the Radar Signs icon. 

The Sign Location dialog box is displayed.

3. Click the Signs list box, then choose --none-- from the list.

4. Click Save.

The Sign Location dialog box closes and the sign is no longer assigned to  the location. The Radar Sign icon is 
dimmed in the location listing.
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Configuring Express Mode for a Location

Configuring Express Mode for a Location
Each location created in Web Director is assigned an express mode configuration, by default. Express Mode allows 
you to quickly and easily configure the Display Settings and Message Settings for a location. It is also the most com-
mon way to set constant (non-scheduled) Display  Message Settings. You can either configure the express mode 
settings  to suit your needs or select a schedule to use for the location.

To configure express mode for the location:

1. In the Menu bar, go to Radar Signs Tools > Sign Settings.

The Radar Sign Settings page is displayed.

2. Find your location in the listing, then click the corresponding  link in the Display Settings column.

If the corresponding link in the Display Settings column is Express Mode, a dialog similar to the following is 
displayed.

Otherwise, if a schedule has already been assigned to the location, a dialog similar to the following is dis-
played.
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Radar Sign Display Settings

In this case, click the Express Mode link.

3. Modify the necessary settings. For descriptions of the available parameters see the following sections.

• For the Display Settings parameters, see              Radar Sign Display Settings below.

• For the Messages parameters, see              Radar Sign Message Settings on the next page.

4. When you are finished, click Save.

The specified Express mode settings are applied to the location.

Radar Sign Display Settings

The Display Settings allow you to control the speed display of the sign, including the range of speeds displayed, 
the speed limits and the use of the strobes. The following table describes the Display Settings that are available in 
Web Director.

Setting Description

Sign Type Displays the model family of the radar sign.

Switch to "Stealth" Mode Places the radar sign in a special mode which allows it to col-
lect traffic data without displaying speeds or messages.

Display is Always ON Disables the Display Range setting and displays vehicle 
speed, speed limit or specified messages for all detected 
vehicles. 

note: This setting is disabled if the Sign Type selected is 
SP 100/400/450.

Display Range Specifies the range of detected speeds for which the radar 
sign displays the following:

• Vehicle speed (on static YOUR SPEED signs)

• Speed limit (on static SPEED LIMIT signs)

• Specified message (on variable message signs)

note: This setting is disabled  if the Display is Always ON or 
the Switch to "Stealth" Mode options are selected.

Speed Limit Specifies the speed limit for that location. This value is used 
to specify the speed limit to display on the static SPEED LIMIT 
signs, and also in reports to determine the number of speed 
limit violations.

SafePace® Cloud QuickStart Guide p. 19



Radar Sign Message Settings

Setting Description

Tolerated Speed Specifies the tolerated speed for the location. Used as an addi-
tional point of programming (for variable message signs) and 
in reports as an additional speed limit.

Flash Digits at Speed Specifies the speed at which the display will flash to get the 
driver’s attention.

Turn Strobe ON at Speed Turns on the Speed Violator Strobe when the sign detects a 
vehicle traveling faster than the specified speed.

Turn OFF Strobe above 
Maximum Displayed Speed

Turns off the  Speed Violator Strobe if the detected vehicle is 
traveling faster than the maximum speed  specified for the Dis-
play Range.

Radar Sign Message Settings

The Message Settings parameters  allow you to attribute specific messages to the specified speed intervals based 
on the Minimum Displayed Speed, Display Range, Speed Limit and Tolerated Speed Limit specified in the Dis-
play Settings. 

The message settings are only displayed if the selected Sign Type is Variable Message Signs. Likewise these set-
tings  are only used if the sign assigned to the location is a Variable Message Sign. If the sign you assign to the loc-
ation is not a Variable Message Sign, the message settings are simply ignored. The following table describes the 
Message Settings that are available in Web Director.

Setting Description 

From Minimum to Speed Limit Specifies what message to display when the sign detects a 
vehicle traveling between the minimum speed specified for 
the Display Range and the Speed Limit.

Inside Tolerated Range Specifies what message to display when the sign detects a 
vehicle traveling between the Speed Limit and the Tolerated 
Speed Limit.

Above Tolerated Range Specifies what message to display when the sign detects a 
vehicle traveling between the Tolerated Speed Limit and the 
maximum speed specified for the Display Range. 

Above Speed Range Specifies what message to display when the sign detects a 
vehicle traveling above the maximum speed specified for the 
Display Range.

Flash Message at Speed Specifies the following: 

• Whether or not to flash the displayed message to get the 
drivers' attention.

• The speed, above which, the detected vehicle must be trav-
eling in order for the displayed message to be flashed.
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Monitoring Your Sign Locations

Monitoring Your Sign Locations
In Web Director, you can monitor your sign locations through either the Dashboards or the Map View. Monitoring 
your locations allows you to quickly see the status of the sign(s), if there are any issues with the power supply to 
the sign, as well as obtain a quick idea of the number and speed of the vehicles detected.  The following table 
describes the  parameters displayed when monitoring your sign locations.

Parameter Description

Name Displays the name of the location.

Address Displays the address of the location.

Traffic Direction Indicates the direction of traffic flow being monitored at the 
location.

Model Indicates the model of the radar sign currently assigned to 
the location.

Sign # Displays the serial number of the radar sign currently 
assigned to the location.

Counter Displays the number of vehicles detected during the time 
period specified by the Display Traffic Statistics Interval sys-
tem parameter.

Avg. Speed Displays the average speed of the vehicles detected during 
the time period specified by the Display Traffic Statistics Inter-
val system parameter.

85% Speed Displays the 85th percentile speed. This is the speed at or 
below which 85% of the detected vehicles traveled during the 
time period specified by the Display Traffic Statistics Interval 
system parameter.

Max. Speed Displays the maximum speed of any of the vehicles detected 
during the time period specified by the Display Traffic Stat-
istics Interval system parameter.

Min. Speed Displays the minimum speed of any of the vehicles detected 
during the time period specified by the Display Traffic Stat-
istics Interval system parameter.

Last Communication Indicates the last time that the sign communicated with the 
Web Director server.

Power Supply Indicates the last reported battery voltage for the sign.

Monitoring Signs from the Dashboard

The Dashboard provides you with a tabular view of the real-time parameters for all of your signs. This allows you to 
monitor all of your signs at glance.
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Monitoring Your Sign Locations

To monitor your signs with the Dashboard:

1. From the Web Director home page, go to  Dashboards.

The Radar Signs Dashboard is displayed.

2. If necessary click the Expand  icon to expand the necessary group(s).

TIP: Click the column headers to sort the Dashboard listing based on that column. The arrow icon indic-
ates the direction of the sort. You can click the header a second time to change the direction of the sort.

Monitoring Signs in the Map View

The Map View allows you to monitor your radar signs based on their geographical location. It displays icons for 
each of your locations, and these location icons are color-coded to indicate the status of the radar sign at each loc-
ation. The Map View also allows you to see a list of recent alerts generated by your radar signs. 

To monitor your signs in the Map View:

1. In the Menu bar, click the Map View icon. 

The Map View page is displayed.
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Monitoring Your Sign Locations

2. If necessary, click and drag the map to display the icons for the signs you want to monitor.

3. Click the icon for the sign you want to monitor.

The monitoring parameters for the sign are displayed in a pop-up window.

To view alerts in the Map view:

» Click the Alerts icon in the lower-right corner of the Map view page.

The list of alerts slides open from the bottom edge of the Map view page.
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Generating Reports and Charts

Generating Reports and Charts
All of the SafePace radar signs capture important traffic data such as vehicle counts, speeds, date and time. You 
can use the Reports Build Wizard in Web Director to generate statistical reports and charts with this data. For 
descriptions of the different types of reports available, see Radar Sign Reports Page below.

To generate a report:

1. In the Menu bar, go to Reports > [report type].

The  Report Build Wizard is displayed.

2. Click the Location list box then choose a sign location from the list.

The report parameters are displayed.

3. Set the required parameters.

4. When you are finished, click Build Report.

The requested report is generated and displayed.

TIP: You can click the minimize icon to hide the Report Build Wizard.

Radar Sign Reports Page

The Radar Sign Reports page has a tiled interface that allows you to select the type of report you want to generate. 
This page contains the following Tiles:

Tiles Description

Weekly Report Generates reports of various traffic statistics arranged by 
hours of the day and days of the week.

Summary Comparison Report Allows you to compare statistics between two periods of time 
for the specified location.

Custom Report Allows you to combine various traffic statistic parameters in 
one report.

Count by Speed Range Report Generates a report that provides a count of the number of 
vehicles detected in different speed ranges. 

Power Supply Report Generates a chart that displays the power supply values repor-
ted by the sign at the selected location.

Synchronization Event Log 
Report

Generates a log of synchronization events for the selected loc-
ation.
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Radar Sign Reports Page

To access the Radar Sign Reports page:

» In the Menu bar, click the Reports icon.

The Radar Sign Reports page is displayed.
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Contacting Technical Support

CONTACTING TECHNICAL SUPPORT

If you have questions or comments regarding SafePace Cloud powered by Web Director, please feel free to con-
tact our technical support center by phone: (866)915-6449, or by email: support@trafficlogix.com
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